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Locator Rapide 

Introduction

Welcome to Locator Rapide, the Imaging software of choice, where digital Images 
are automatically saved, from a range of Konica Minolta Microfilm or Book Scanners, 
directly to your computer, all by the click of a mouse. 

Locator Rapide 

Locator Rapide is a high-speed digital image processing system, which brings 
unprecedented ease and versatility to the processing of scanned images. It combines 
a variety of digital imaging technologies that allow an operator to view, edit, print, and 
email without ever leaving the application. 

System Functions 

Locator Rapide provides operators with an easy-to-use productive environment. The 
operator can define and invoke as many Work Areas (batches) as required. Images 
that are scanned into a work area, are automatically saved in a chronological order. 
This permits the operator to review or manipulate the images prior to printing, e-
mailing or even saving to another location. Brightness, contrast, despeckle and other 
scan parameters, can easily be adjusted to compensate for poor images, ensuring 
high quality output every time. 

Once an image has been scanned, a number of additional functions can be utilized. 
Annotation marks can be added to the image. You can despeckle all or part of an 
image, print or save a defined area of the displayed image, or even move or copy 
images in their entirety between work areas (batches).  
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Work Areas 

Work Areas Overview 

When working with images, the need to store and work with a specific set of images 
often becomes necessary. Locator Rapide easily fulfils this need with the use of 
Work Areas (also known as batches). A Work Area provides a holding place for 
image files. Once a work area is created, the images within it, can be stored and 
retained indefinitely. 

Simply select the work area you wish to work with, from the Work Areas box. In 
addition you can create a New work area, Delete or even Rename the highlighted 
work area. 

Create New Area 

To create a new work area, simply click on the New button under Work Areas as 
shown below. 

When creating a new work area for the first time, a default area name (Area001) is 
already entered for you. Clicking the OK button will create the new work area using 
the default area name. 
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If you do not wish to accept the default area name, simply type over it with a new 
name.

A new work area called Covergold will now be created when the OK button is clicked. 
The default work area name will now be updated to Covergold. 

When you click on the New button under Work Areas again, the default area name is 
again entered for you (as shown below), but this time with the extension 
Covergold001, this is because work area name Covergold has previously been 
created.

Delete Area 

To delete a work area, simply highlight the work area you wish to delete and click on 
the Delete button. 
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Work Areas 

The following warning dialog box is displayed, if images exist in the work area you 
are about to delete. 

Clicking the Yes button deletes the folder and it's contents permanently from your 
computer. This process is final and cannot be undone.

Rename Area 

To rename a work area, simply highlight the work area you wish to rename and click 
on the Rename button. 

The following dialog box will then be displayed.
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Typing in the new name and clicking on the OK button, confirms the changes to the 
current work area name.

Menu Options 

Right clicking the mouse button within the Work Areas box, displays the following 
menu options. 

Copy All Pages to Location, lets you copy all the pages for the highlighted work 
area, to an external location. Clicking on this option, displays the following browse for 
folder dialog box. 
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Work Areas 

Navigate to the desired location, and click on the OK button to begin the process. 

Copy All Pages to Multi Page File, lets you copy all the pages for the highlighted 
work area, to a new or existing multipage file, in an external location. Clicking on this 
option, displays the following dialog box. 
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From the above dialog box, navigate to the location where you would like to save the 
multipage file. In the File name: box, enter a name for the file you are about to 
create, or select a previously created file, that you would like to append the selected 
pages to. In the Save as type: box, choose one of the displayed file formats. 
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Finally, click on the Save button to begin the process. 

When creating multipage files, the Save as type: should reflect the file format, for the 
type of files you are saving. For example, you cannot save colour images using the 
Tiff G4 file (*.tif) format, doing so would result in the following error message. 

When the file has been successfully created, the following message box is displayed. 
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Email All Pages As Multi Page PDF, combines all the pages for the highlighted 
work area, into a single multipage PDF file for e-mailing as an attachment. Clicking 
on this option, displays the following dialog box. 

When the multipage file has been created, it is then added as an attachment to the 
default mail recipient as shown below. 



Pages

Pages Overview

Once you have selected a Work Area to work with, the Pages box is automatically 
populated with the total number of previously saved images, for the work area (as 
shown below). 

ViewClicking on individual page numbers within the pages box, enables you to  the 
selected image. 

For multiple page selection (when e-mailing, moving or copying), hold down the Ctrl
key on your keyboard while clicking on the individual page numbers with the mouse. 

The Previous and Next buttons, lets you to navigate through the available page 
numbers, loading the relevant image for viewing. 

The Delete button (next to the pages box), lets you to delete single or multiple pages 
when highlighted, from the selected work area. 

The Insert File button, lets you to add previously saved images from an external 
location, into the selected work area. 
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The Move and Copy buttons, allow total control for moving or copying images 
between work areas. 

Optionally, right clicking the mouse button within the Pages box, displays the 
following menu. 

Email Pages, e-mails the selected pages as individual attachments. 

Email Pages As Multi Page PDF, combines the selected pages into a single 
multipage PDF file for e-mailing. 

Email File From Location, e-mails the selected file, from outside of the Locator 
Rapide work area environment. 

Copy Pages to Location, lets you copy one or more highlighted pages, to another 
location, outside of the Locator Rapide work area environment. 

Copy Pages to Multi Page File, lets you copy all the highlighted pages, to a new or 
existing multipage file, outside of the Locator Rapide work area environment. 

Select All Pages, highlights all the pages within the pages box.   

Reverse Page Number Order, re arranges the page numbers starting with the 
highest number first and vice versa. 

Previous

Clicking the Previous button, loads the previous image for viewing.
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Next

Clicking the Next button, loads the next image for viewing.

Delete Page 

Clicking on the Delete button, deletes all the highlighted page numbers within the 
Pages box (as shown below). 

The following message box will then be displayed. 

Clicking the Yes button deletes all the highlighted images from your computer. This
process is final and cannot be reversed.
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Insert File 

Clicking the Insert File button, lets you add previously saved images from an external 
location, into the current work area. Files will be inserted after the selected 
highlighted page number. 

The following Select Files to Insert dialog box is then displayed. You can now 
navigate to the desired location, and select the files you would like to insert into the 
current work area. 

Clicking the Open button inserts the selected files into the current work area.  
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Move

The Move button, lets you move one or more highlighted pages, from one work area
to another. You can also move pages within the same work area. 

Select the pages you want to move, by holding down the Ctrl key on your keyboard, 
while clicking on the individual page numbers with the mouse. To select a range of 
consecutive page numbers, click on the first page number with the mouse, then, 
while holding down the Shift key on your keyboard, click on the last page number 
with the mouse. Clicking on the Move button displays the following dialog box. 
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Next, select the work area you want to move the selected pages to, and also the 
position within the work area where these pages should be placed. The information 
area on the bottom of the move pages dialog box, indicates the work area you want 
to move the pages to, and the number of pages that already exist within that work 
area. Clicking on the OK button confirms the move. 

Copy

The Copy button, lets you copy one or more highlighted pages, from one work area
to another. You can also copy pages within the same work area. 

Select the pages you want to copy, by holding down the Ctrl key on your keyboard, 
while clicking on the individual page numbers with the mouse. To select a range of 
consecutive page numbers, click on the first page number with the mouse, then, 
while holding down the Shift key on your keyboard, click on the last page number 
with the mouse. Clicking on the Copy button displays the following dialog box. 
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Next, select the work area you want to copy the selected pages to, and also the 
position within the work area where these pages should be placed. The information 
area on the bottom of the copy pages dialog box, indicates the work area you want to 
copy the pages to, and the number of pages that already exist within that work area. 
Clicking on the OK button confirms the copy. 

Email Pages

Email Pages, lets you e-mail the highlighted pages as individual attachments. Right 
clicking the mouse button within the Pages box, displays the following menu. 

Clicking on Email Pages, begins the process of adding the selected pages as 
individual attachments, to the default mail recipient. 
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Email Pages As Multi Page PDF

Email Pages As Multi Page PDF, lets you combine all the highlighted pages, into a 
single multipage PDF file for e-mailing as an attachment. Right clicking the mouse 
button within the Pages box, displays the following menu. 

Clicking on Email Pages As Multi Page PDF, begins the file creation process. 

When the multipage file has been created, it is then added as an attachment to the 
default mail recipient as shown below. 
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Email File From Location

Email File From Location, lets you email files from an external location, outside of the 
Locator Rapide environment. Right clicking the mouse button within the Pages box, 
displays the following menu. 

Clicking on Email File From Location, displays the following dialog box. 
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After selecting the files you wish to e-mail, clicking the open button at the bottom of 
the dialog box, adds the selected files as attachments the default mail recipient. 

Copy Pages to Location

Copy Pages to Location, lets you copy one or more highlighted pages, to another 
location, outside of the Locator Rapide environment. Right clicking the mouse button 
within the Pages box, displays the following menu. 
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Clicking on Copy Pages to Location, displays the following browse for folder dialog 
box.

Navigate to the desired location, and click on the OK button to begin the process. 

Copy Pages to Multi Page File

Copy Pages to Multi Page File, lets you copy all the highlighted pages, to a new or 
existing multipage file. When copying pages to an existing multipage file, the pages 
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will be appended to the end of the file. Right clicking the mouse button within the 
Pages box, displays the following menu. 

Having selected the pages, clicking on Copy Pages to Multi Page file, displays the 
following dialog box. 

From the above dialog box, navigate to the location where you would like to save the 
multipage file. In the File name: box, enter a name for the file you are about to 
create, or select a previously created file, that you would like to append the selected 
pages to. In the Save as type: box, choose one of the displayed file formats. 
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Finally, click on the Save button to begin the process. 

When creating multipage files, the Save as type: should reflect the file format, for the 
type of files you are saving. For example, you cannot save colour images using the 
Tiff G4 file (*.tif) format, doing so would result in the following error message. 

When the file has been successfully created, the following message box is displayed. 
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Select All Pages 

Select All Pages, lets you select and highlight all the pages within the Pages box. 
Right clicking the mouse button within the Pages box, displays the following menu. 

Reverse Page Number Order 

Reverse Page Number Order, lets you reverse the order of the page numbers as 
displayed in the Pages box. Right clicking the mouse button within the Pages box, 
displays the following menu. 

24



Pages

25





View Image 

View Image Overview 

To view an Image, click on a page number from the Pages box to display the image 
for viewing.

In addition, a variety of features within Locator Rapide, give users the ability to 
change the way images (pages) are displayed. Some of the options include zooming 
in or out of an image, deskew, despeckle, crop and scan print to name but a few. 

Normal View, the default for viewing a selected image (page). 

Full Screen View, displays the selected image (page) in full screen mode. 

Split Screen View, allows viewing of up to four selected images (pages) 
simultaneously.

Restore Page, restores the originally selected image (page) for viewing, discarding 
any changes made. 

Normal View 

Selecting a page number from the Pages box, displays the image for viewing as 
shown below. The work areas, pages and scanner settings options, are displayed to 
the left of the window whilst the image is displayed to the right. This is classed as the 
Normal View.  
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Full Screen View 

To enable Full Screen View, simply right click the mouse button over the displayed 
image, and select Full Screen View from the following menu.  

The displayed image now occupies the whole of the window, with the work areas, 
pages, and scanner settings options completely hidden from view. This is classed as 
the Full Screen View. 
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View Image 

Whilst the controls are hidden from view, you can still navigate to the next or previous 
page (image), by holding down the Alt key and depressing the letter N (for next 
page) or P (for previous page) respectively on the keyboard. 

To revert back to the Normal View, select the option from the menu as shown below.  

Split Screen View 

Up to 4 pages (images) can be selected, individually or consecutively to view in split 
screen mode. To enable Split Screen View, simply right click the mouse button over 
the displayed image, and select 4 Page Split Screen View from the following menu. 
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The pages (images) shown below in split screen view, have been individually 
selected, by holding down the Ctrl key on your keyboard, while clicking on the 
individual page numbers with the mouse. To view consecutive pages, simply 
highlight the first page from the Pages box, and click on the 4 Page Split Screen 
View option from the toolbar drop down button (as shown above). 

From the split screen view, select the image to work with by ticking the check box, 
which is displayed in the top left hand corner of each image. 
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When the check box is ticked, all image processing functions are applied to this 
image alone. 

To close the split screen view and return to the Normal View, select the option from 
the menu as shown below. 

Restore Page 

To revert back to the original image and cancel any image processing functions that 
may have been applied, click on either the original page number from the Pages box, 
or Restore Page from the pop up menu, which is displayed when you right click the 
mouse button whilst on the actual image. 
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Toolbar 

Toolbar Overview 

The Locator Rapide Toolbar 

The Locator Rapide Toolbar, contains buttons that make the most routinely used 
functions available with one click of the mouse. Like the Menu Bar, the buttons in the 
Toolbar are enabled and disabled based on what actions you are performing. 

The following table shows each Toolbar button and describes its function: 

Button Function

Open Work Areas. Lets you create or view available 
work areas.

Scan New. Scans and saves the image or document 
currently in the scanner. 

Scan and Print. Scans the image or document 
currently in the scanner and outputs it directly to a 
printer.

Select Source. Displays a list of the available 
scanning devices. 

Email Pages. Lets you email the selected pages. 

Email File From Location. Lets you email selected 
files from an external location. 

Copy Pages to Location. Lets you copy and save the 
selected pages to an external location. 

Copy Pages to Multi Page File. Lets you copy and 
save the selected pages, to a single multipage file, in 
an external location. 

Print. Opens the print dialog box which allows you to 
print the viewed image. 

Print As Seen. Opens the print dialog box which only 
prints the contents of the displayed window. 
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Save. Saves changes to the displayed image. 

Normal View. The work areas, pages and scanner 
settings options, are displayed to the left of the 
window whilst the image is displayed to the right. 

Full Screen View. The displayed image occupies the 
whole of the window, with the work areas, pages, and 
scanner settings options completely hidden from view. 

4 Page Split Screen View. Up to 4 pages can be 
selected, individually or consecutively to view in split 
screen mode. 

Pan. Displays a floating window showing the complete 

image. By dragging the mouse within this floating 
window, the main image displayed is repositioned.

Zoom Image. Zooms (enlarges) the displayed image.

Rotate Image. Rotates the displayed image. 

Normal. Closes the Select Area tool and reverts back 
to normal mode.

Select Area. Lets you draw a rectangle on top of the 
displayed image, to which you can apply certain 
image processing functions. 

Undo. Reverses the changes made to the displayed 
image.

Deskew. Deskew's the displayed image. 
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Despeckle. Despeckle either a part or the whole of 
the displayed image. 

Contrast Adjustment. Displays a floating window 
where you can adjust the brightness, contrast and 
gamma values of the image displayed. 

Thumbnails. Displays thumbnails of all the images 
within the work area. The size of the displayed 
thumbnail can be can be altered to small, medium or 
large.

Scan New 

To begin scanning a new image into the current work area, simply click the Scan 
New button from the toolbar as shown below. 

Alternatively, click the down arrow on the toolbar button, and select Scan New from 
the drop down menu. 

When the scanner has completed the scan cycle, the scanned image will be 
displayed as shown below, using the default settings taken from the scanner settings 
dialog box. 
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Default settings used to scan image above, taken from the scanner settings dialog 
box.

If the Scanner Settings option is ticked (as shown above), then the scanner setup 
dialog is displayed. The user interface shown below applies to the MS6000 Microfilm 
Scanner only. The device driver user interface differs greatly, depending on the 
manufacturer.
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Selecting the Batch Scan option from the scanner settings dialog box, allows you the 
flexibility to carry on scanning by utilising the Start button on the front panel of your 
Microfilm Scanner, or in the case of a Book Scanner, the left and right switches on 
the Book Scanner itself. 
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The settings for each scan can be altered via the front panel of the microfilm scanner, 
prior to pressing the Start button. 

When using the Batch Scan option, the scanner settings dialog box will be greyed 
out, with a DONE button immediately visible underneath the scanner settings dialog 
box.

When you have finished or want to stop batch scanning, simply click on the DONE
button as shown above. 

Prior to scanning a new image into the existing work area, you can select to Append, 
Insert or Replace the current image. 

  To Append scanned images to the end of the current work area, 
select the append option. 

  To Insert scanned images into the current work area, select the 
insert option. 
   Images will be inserted after the selected highlighted page number. 

  To Replace (re-scan) an image in the current work area, select the 
replace option. 
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Scan Print 

Scan and Print, allows you to Scan the Image and output it directly to the default 
printer on your computer, without saving the image to the current work area.

To turn on scan and print, simply click the down arrow on the toolbar button, and 
select Scan and Print from the drop down menu. 

When the scanner has completed the scan cycle, the scanned image will be sent 
directly to the default printer on your computer, utilising the default settings taken 
from the scanner settings dialog box. The scanned image will not be saved to the 
current work area.

Save
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To Save any changes made to the displayed image, simply click the Save button on 
the toolbar.

Pan Window 

The Pan Window is especially useful, when you have zoomed in on the displayed 
image and would like to move around the Image, whilst retaining the current zoom 
level. Clicking the Pan button on the toolbar, displays the Pan Window, as shown 
below.

Holding down the left mouse button on the black rectangle in the Pan Window, whilst 
moving the mouse, enables you to move the main displayed image to a different 
area, whilst retaining the current zoom level. 

Normal

Clicking the Normal button on the toolbar, closes the Select Area tool if open, and 
reverts back to the default mode. 
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Select Area 

Select Area Overview 

Clicking on the Select Area tool from the toolbar, lets you draw a rectangle over the 
displayed image with the mouse, to which you can then apply some image 
processing functions. 

Crop, lets you crop the displayed image, to the bounds of the rectangle. 

Despeckle, lets you despeckle the area of the rectangle drawn. Only applies to a 
one-bit image. 

Cut, lets you cut out the area of the rectangle drawn, from the displayed image. 

Copy, lets you copy the area of the rectangle drawn to the clipboard, for later use. 
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Paste, lets you paste a previously Cut or Copied rectangle area, into the currently 
displayed image. 

Paste New Page, lets you paste a previously Cut or Copied rectangle area, into a 
new page (image). 

Restore Page, restores the originally selected image (page) for viewing, discarding 
any changes made. 

Crop

To Crop an area of a displayed image, use the Select Area tool from the toolbar, to 
draw a rectangle over the displayed image. With the rectangle drawn, right click the 
mouse button to display the pop up menu, as shown below. 

From the pop up menu, select the Crop option to crop the image. 
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Despeckle Area 

To Despeckle an area of a displayed image, use the Select Area tool from the
toolbar, to draw a rectangle over the displayed image. With the rectangle drawn, right 
click the mouse button to display the pop up menu, as shown below. 
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From the pop up menu, select the Despeckle option to despeckle the area selected. 

If there is no rectangle drawn on the image, selecting the Despeckle option from the 
pop up menu, will despeckle the whole image. 

Cut

The clipboard is a windows data structure used to exchanged data between 
applications, It is a common area where applications place data and others can 
access it. These operations are usually referred to as Cut (place data in) and 
Paste (take data out). 

To Cut an area of a displayed image and save it to the clipboard, use the Select Area
tool from the toolbar, to draw a rectangle over the displayed image. With the 
rectangle drawn, right click the mouse button to display the pop up menu, as shown 
below.
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From the pop up menu, select the Cut option to cut the selected area and save it to 
the clipboard. 

Paste New Page 
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The clipboard is a windows data structure used to exchanged data between 
applications, It is a common area where applications place data and others can 
access it. These operations are usually referred to as Cut (place data in) and Paste 
(take data out). 

To Paste into a New Page a selected area of a displayed image, use the Select Area
tool from the toolbar, to draw a rectangle over the displayed image. With the 
rectangle drawn, right click the mouse button to display the pop up menu, as shown 
below.

Selecting the Paste New Page option from the pop up menu, copies and saves the 
selected area to a new page, that will be appended to the current Work Area.
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Undo

To Undo a previous action (i.e. despeckle, crop...), simply click on the Undo button 
on the toolbar.

Deskew

Deskew provides for optical de-skewing of scanned images (Tif file format only). To 
deskew the displayed image, simply click on the Deskew button on the toolbar.

Despeckle

To Despeckle the entire displayed image, simply click the Despeckle button on the 
toolbar. To Despeckle an area of the displayed image, see the Despeckle section 
under Select Area.

Contrast Adjustment 
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The Contrast Adjustment displays the Image Processing: Brightness, Contrast and 
Gamma dialog. The sliders in the Settings area are used to alter the brightness, 
contrast and gamma-correction parameters, for either the whole, or a section of the 
displayed image, as set out under the Region of Interest.  

The effect of the changes are displayed on the Preview Image. If the image is 
particularly large there will be a long time delay while the image is being rendered. 

Clicking the apply button, applies the changes from the preview window, to the main 
image being viewed. 

Thumbnails

To view a preview thumbnail of each image within a work area, click on the thumbnail 
button from the toolbar.

The thumbnails will be displayed at the bottom of the image being viewed as shown 
below.
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Clicking on individual thumbnails, replaces the full Image in the main window. 

Only a set number of thumbnails can be previewed at a time, use the scroll bar to the 
right of the thumbnail window to navigate to the desired location as shown below. 

There are three set sizes that can be selected when viewing thumbnails, small, 
medium and large. Clicking the down arrow on the thumbnail button allows you to 
select one of the predefined sizes. The size of the thumbnail will automatically adjust 
within the thumbnail window. 

Small
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Menu Bar 

File

Image Info 

Clicking on Image Info from the File menu, displays information about the currently 
viewed image file.  

Select Source 

Before Locator Rapide performs any scanning operation, the user has to select the 
device (scanner) he wishes to use, from a list of available scanning devices. 

From the File menu, click on the Select Source option as shown below. 
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The following select source dialog box is displayed, with a list of all the installed 
TWAIN sources on the system.

The user can select the new default TWAIN device or they can cancel. If they click on 
Select, TWAIN remembers the new default device. 

Please note that the Select Source dialog lists Sources (TWAIN drivers), not physical 
devices. It will list devices even if they are currently off-line or unplugged. Also, two 
devices that use the same driver will only appear once in the TWAIN device list. 

Print Preview 

Clicking on Print Preview from the File menu, displays the Print Preview dialog, 
where you can preview a page before printing. 
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Print

To Print to any Windows printer on the system with complete control, select Print 
from the File menu. 

The following print dialog box (or similar) will then be displayed. 
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Options

Annotation Tools 

To add Annotation Marks to the Image being viewed, click on Annotation Tools from 
the Options menu. 

The following Annotation Toolbar will then be displayed. 
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The following table shows each Toolbar button and describes its function: 

Button Function

The Select Annotations button, enables you select any 
previously created marks on an image. 

The Filled Rectangle button, enables you to cover 
areas of an image with a rectangle. Clicking the Filled 
Rectangle button with the left mouse button, and then 
dragging the resulting rectangle over the items to be 
covered, creates this mark. Pressing the right mouse 
button after the mark is created activates the popup edit 
menu for this mark. 

The Hollow Rectangle button, enables you to surround 
areas of an image with a rectangle. Clicking the Hollow 
Rectangle button with the left mouse button, and then 
dragging the resulting rectangle over the items to be 
surrounded, creates this mark. Pressing the right 
mouse button after the mark is created activates the 
popup edit menu for this mark. 

The Highlighter button, enables you to highlight part of 
an image. Clicking the Highlighter button with the left 
mouse button, and then dragging the resulting 
rectangle over the area to be highlighted, creates this 
mark. Pressing the right mouse button after the mark is 
created activates the popup edit menu for this mark. 

The Straight Line button, enables you to create straight 
lines. You can place lines anywhere over an image. 
Clicking the Line button with the left mouse button, then 
clicking the left mouse button at the point where the line 
begins, holding the left mouse button down while 
dragging the line to the point where it ends, and 
releasing the left mouse button when finished, draws 
the line. Pressing the right mouse button after the mark 
is created activates the popup edit menu for this mark. 

The Typed Text button, enables you to add descriptive 
text to the image. The text can be created in various 
fonts*, sizes or colours. The text lays over the original 
image. *You can use any font unless the mark's are 
rotated. In this case, due to Window's limitations, you 
must use a Window's True Type font. 
Clicking the Typed Text button with the left mouse 
button, and then dragging the resulting rectangle over 
the area to be annotated, creates this mark. This 
rectangle serves as a guide to the positioning of the 
Text annotations. To modify the text, double click the 
left mouse button when the cursor is over the text mark. 
The cursor appears at the beginning of the text to allow 
editing.
Note: If you create a text mark without any text, and 
with a transparent background, the resulting mark will 
exist but will not be visible. 
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The Attach A Note button, enables you to add notes to 
an image or document. 
Clicking the Attach A Note mark with the left mouse 
button, and then dragging the resulting rectangle over 
the area to be annotated, creates this mark. 
While creating this mark and entering text on to the 
note, pressing the right mouse button activates the 
popup menu that enables you to change the font or the 
background colour of the note. 

The Text From File button, enables you to add 
descriptive text to an image or document. The text can 
be created in various fonts*, sizes, colours and even 
angles of presentation. The text lays over the original 
image or document. 
*You can use any font unless the mark's are rotated. In 
this case, due to Window's limitations, you must use a 
Window's True Type font. 
Clicking the Text From File button with the left mouse 
button, and then dragging the resulting rectangle over 
the area to be annotated, creates this mark. This 
rectangle serves as a guide to the positioning of the 
Text annotations. 
To modify the text, double click the left mouse button 
when the cursor is over the text mark. The cursor 
appears at the beginning of the text to allow editing. 
While creating this mark and entering text, pressing the 
right mouse button activates the popup menu that 
enables you to change several attributes of the mark. 
Note: If you create a text mark without any text, and 
with a transparent background, the resulting mark will 
exist but will not be visible. 

The Text Stamp button, enables you to annotate with 
text.
Clicking the Text Stamp button with the left mouse 
button creates this mark. Pressing the right mouse 
button after the mark is created, activates the popup 
edit menu that allows you to enter the text of the stamp. 

The Freehand Line button, enables you to use freehand 
drawing for annotation. 
Clicking the Freehand Line button with the left mouse 
button, dragging the image, and then releasing the left 
mouse button, creates this mark. Pressing the right 
mouse button after the mark is created, activates the 
popup edit menu for this mark. 

The Arrow button, enables you to create an arrow over 
an image. It allows you to point to areas of a document 
that may be of interest to its reader. 
You can create this mark by clicking the Arrow button 
with the left mouse button, dragging the image, and 
then releasing. The head of the arrow is drawn at the 
point where the left mouse button is first pushed, and 
the tail (end) of the arrow is set at the location where 
the left mouse button is released. Pressing the right 
mouse button after the mark is created activates the 
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popup edit menu. 

The Hollow Ellipse button, enables you to create a 
hollow ellipse to surround important areas. You can 
create this mark by clicking the Hollow Ellipse button 
with the left mouse button, dragging the image, and 
then releasing the left mouse button. Pressing the right 
mouse button after the mark is created activates the 
popup edit menu. 

The Filled Ellipse button, enables you to cover areas of 
an image with an ellipse. 
You can create this mark by clicking the Filled Ellipse 
button with the left mouse button, dragging the image, 
and then releasing the left mouse button. Pressing the 
right mouse button after the mark is created activates 
the popup edit menu. 

The Hollow Polygon button, enables you to surround 
areas of an image with a polygon. You can create this 
mark by: 
1. Clicking the left mouse button at the point where the 
polygon starts. 
2. Drag and click the left mouse button to create each 
vertice you want to add. 
3. Double-click the left mouse button to complete the 
polygon.
4. Press the right mouse button after the mark is 
created to activate the popup 
edit menu. 

The Filled Polygon button, enables you to cover areas 
of an image with a polygon. 
You can create this mark by: 
1. Clicking the left mouse button at the point where the 
polygon starts. 
2. Drag the mouse to the location of a vertice and click 
the left mouse button. 
3. Repeat step 2 to add the desired number of vertices 
to the polygon, clicking 
the left mouse button to add a vertice. 
4. Double-click the left mouse button to complete the 
polygon.
5. Press the right mouse button after the mark is 
created to activate the popup 
Edit menu. 

The Polyline button, enables you to create several 
connected straight lines by dragging and clicking the 
mouse. You can create this mark by: 
1. Clicking the left mouse button at the point where the 
polyline starts. 
2. Drag the left mouse button to the location of a 
vertice. 
3. Drag and click the left mouse button to create each 
additional vertice. 
4. Move the cursor to the location where the polyline 
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ends.
5. Double-click the left mouse button. 
Pressing the right mouse button after the mark is 
created activates the popup Edit menu. 

Print Annotations 

To turn on Print Annotations, click on the Options menu and select Print Annotations. 
When turned on, enables printing of annotation marks with the image. 

Settings

Save Scanner Settings 

Some TWAIN devices allow the application to save all the settings used to a file. 
When supported, it is a great way of setting a scanner to a predefined completely 
known state, prior to scanning. This function is not universally supported by scanner 
manufacturers.

To Save Scanner Settings, click on the Settings menu and select the option as 
shown below. 

The following dialog box is then displayed. 
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From the above dialog box, select the folder and file name you wish to save the 
current TWAIN device settings to, and click on the save button.  

Restore Scanner Settings 

Some TWAIN devices allow the application to restore the scanner settings from a 
previously saved file. When supported, it is a great way of setting a scanner to a 
predefined completely known state, prior to scanning. This function is not universally 
supported by scanner manufacturers. 

To Restore Scanner Settings, click on the Settings menu and select the option as 
shown below. 

The following dialog box is then displayed. 
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From the above dialog box, select the folder and file name you wish to restore the 
current TWAIN device settings to, and click on the open button. The scanner settings 
are now restored to a predefined state. 

Use Auto Card Feeder 

Use Auto Card Feeder is only applicable, when the Auto Card Feeder 7 (ACF-7) is 
fitted to either the MS6000 or MS7000 Microfilm Scanner. 

To use this option click on the settings menu, and select Use Auto Card Feeder as 
shown below. 

The default scanner settings control now has three additional options displayed. 
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Selecting the Use Auto Card Feeder option, lets the application know that you will 
be scanning from the ACF-7 

Selecting the Scan All Cards option, automatically scans all the cards that are 
placed in the hopper of the device. 

If you only want to scan a finite number of cards, deselect the Scan All Cards option, 
and enter a value in the No of Cards to Scan box. 

When you start a scan, the set amount of cards will be scanned from the ACF-7. 

Help

About Locator 

The About Locator message box, displays the information required for support 
purposes.
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